CHAPTER

Installing CiscoWorks
Common Services

This chapter describes the tasks you have to perform for installing, upgrading, and
uninstalling CiscoWorks Common Services on a Windows system.

This chapter contains:

Installation Overview, page 2-2

Preparing to Install Common Services, page 2-3
Performing New Installation, page 2-7
Performing Upgrade Installation, page 2-17
Reinstalling Common Services, page 2-28
Verifying Installation, page 2-38

Checking for Installation Errors, page 2-38

Uninstalling Common Services, page 2-39
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I Installation Overview

Installation Overview

This section provides an overview of the CiscoWorks Common Services
installation tasks. Table 2-1 contains references to more detailed information
about each task.

Table 2-1 Installing Common Services Task Overview
Task Steps References
Prepare to install 1. Verify server requirements are  |“Prerequisites” chapter, “Server

Common Services.

met

Requirements” section on page 1-3

2. [Install required Microsoft “Installing Required Microsoft Software”
software on the server if it is not |section on page 2-5
already installed

3. Verify client requirements are “Prerequisites” chapter, “Client
met Requirements” section on page 1-7

4. Verify TCP ports that “TCP and UDP Ports Information”

CiscoWorks uses and check for
conflicts with existing
applications.

To find whether a TCP port is in
use or not, use the following
command:

netstat -a -n -f inet -P tcp
| grep port number.

If the port is in use, it will be
displayed that the port is in
LISTEN state.

section on page 2-6

Install Common
Services.

Run the installation program

“Performing New Installation” section on
page 2-7

“Performing Upgrade Installation”
section on page 2-17

“Reinstalling Common Services” section
on page 2-28
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Preparing to Install Common Services

Table 2-1 Installing Common Services Task Overview (continued)
Task Steps References
Verify and 1. Verify that all correct services “Verifying Installation” section on
troubleshoot are installed page 2-38
installation. 2. Analyze installation error “Troubleshooting the Installation”
messages appendix, “Understanding Installation
Error Messages” section on page A-4

Preparing to Install Common Services

This section details the important notes and preparations before you start
installing Common Services.

This sections contains:
e Installation Notes, page 2-3
¢ Installing Required Microsoft Software, page 2-5
e TCP and UDP Ports Information, page 2-6

Installation Notes

Before you install Common Services, make sure your server and client
environments meet the hardware and software requirements described in
Chapter 1, “Prerequisites.”

e We recommend you:
— Close all applications before running Common Services installation.

— Run the installation from a local CD or a local hard drive to avoid errors
due to slow network performance.

— Install Common Services on a system that has a static IP address.
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Preparing to Install Common Services

We recommend that you do not:

— Install Common Services on a system that is configured as a primary or
backup domain controller.

— Install Common Services on a FAT file system.
— Install Common Services on Windows XP.
— Run any other program when installation is in progress.

— Install Common Services on Advanced Server with terminal services
enabled in application server mode.

— Install Common Services on a system with Internet Information Services
(IIS) enabled.

— Install Common Services on a system that does not have name lookup.

Do not install Common Services and ACS on the same machine. This is
because ACS mandates CiscoWorks to be configured as an AAA client in it
for CiscoWorks to avail AAA service.

At the same time, you cannot configure ACS as an AAA client as is required
when ACS and CiscoWorks coexist. Hence the configuration required for
ACS integration will fail.

Disable the virus scan software on your system. You can restart it after
installation is complete.

Disinfect your system and end any Internet Explorer processes that are not
responding. If you run the Common Services installer or uninstaller on a
system that is infected with a virus or has an Internet Explorer process that
has stopped responding, the installation or uninstallation process might stop
unexpectedly.

If you are running HP Network Node Manager, the installation might take
significantly longer to complete. Stop all HP Network Node Manager
services before installing Common Services.

You might also see warnings that the installation system is running out of disk
space. You can choose to free disk space on the system and click Yes to
continue, or click No to exit the installation.

Do not select an encrypted directory. Common Services does not support
directory encryption.

Installation and Setup Guide for CiscoWorks Common Services 3.0 (Includes CiscoView) on Windows

78-16497-01 |



| Chapter2 Installing CiscoWorks Common Services

Preparing to Install Common Services

Installing Required Microsoft Software

Step 1

Step 2

Step 3

Installing Common Services requires three or more Microsoft software
applications. This depends on your system. The major steps required for installing
Common Services are:

Make sure the system has Microsoft Windows or Advanced server with service
pack 3 or 4 installed. To verify the existing service pack:

From the Start menu, select Run and enter winver.

e Ifversion 5.0 Service Pack 3 Or version 5.0 Service Pack 4 appears in
the Version field, Service Pack 3 or 4 is already installed.

e Ifthis information does not appear, Service Pack 3 or 4 is not installed. Install
it now.

Make sure Microsoft Internet Explorer 6.0 is installed in the client and is running
JVM version 5.0.0.3802 and later.

To verify the JVM version:
a. From the browser, select View > Java Console.

b. Enable Java Console if it is not listed in View. Select Tools > Internet
Options > Advanced.

c. In the Microsoft VM section, select the Java Console Enabled.

d. Restart Internet Explorer.

Make sure ODBC Driver Manager 3.5.10 or later (in 3.5x) is installed.
To verify the version of ODBC Driver Manager:

a. From the Windows desktop, select Start > Settings > Control Panel >
Administrative Tools > Data Sources (ODBC).

b. Select the About tab.
If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later.
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Step4  Make sure that all ODBC Core Components have the same version number. See
the Microsoft web site for installation instructions.

While installing the required server software:

¢ Always retain the newer file when you are prompted by an installation
program to replace a newer file with an older file.

e Always reboot your system when you are prompted to do so by an installation
program.

* You might be asked to register with Microsoft before downloading some of
the required software. Complete the registration. Selections you make during
registration will not affect the installation.

TCP and UDP Ports Information

Table 2-2 lists the TCP and UDP ports used by Common Services.

Table 2-2 TCP and UDP ports used by CiscoWorks Common Services

Port Number Protocol Service Name Traffic Direction
514 UDP Syslog Incoming
1741 TCP CiscoWorks HTTP Incoming
43441 TCP Database Incoming
443 TCP CiscoWorks HTTP server in SSL mode Incoming
9007 TCP Tomcat shutdown Incoming
9009 TCP Ajp13 connector used by Tomcat Incoming
40050 to 40070 |TCP Ports used by DCR and OGS Incoming
40401 TCP License Server Incoming
22 TCP Secure Shell (SSH) Outgoing
23 TCP Telnet Outgoing
80 TCP Hyper Text Transfer Protocol (HTTP) Outgoing
161 UDP Standard port for SNMP polling Outgoing
162 UDP Standard port for SNMP traps Outgoing

Installation and Setup Guide for CiscoWorks Common Services 3.0 (Includes CiscoView) on Windows
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Table 2-2 TCP and UDP ports used by CiscoWorks Common Services (continued)

Port Number Protocol Service Name Traffic Direction

42340 TCP CiscoWorks Daemon Manager Incoming and Outgoing
42342 UDP Osagent Incoming and Outgoing
69 UDP Trivial File Transfer Protocol (TFTP) Incoming and Outgoing
1683 TCP Internet Inter-ORB Protocol (IIOP) port  |Incoming and Outgoing

for CiscoWorks gatekeeper

1684 TCP IIOP port for CiscoWorks gatekeeper Incoming and Outgoing
8088 TCP HIPO port for CiscoWorks gatekeeper Incoming and Outgoing
514 TCP Remote Copy Protocol Incoming and Outgoing
42350 (default), |UDP Event Services Software Service Incoming and Outgoing
44350 (alternate)

42351 (default), |TCP Event Services Software Listening Incoming and Outgoing
44351 (alternate)

42352 (default), |TCP Event Services Software HTTP Incoming and Outgoing
44352 (alternate)

42353 (default), |TCP Event Services Software Routing Incoming and Outgoing

44353 (alternate)

Performing New Installation

The Common Services installation program takes approximately 15 minutes to
complete on a Windows system with the minimum required hardware. This can
extend to one hour if you perform network management integration while

installing.

For information on setting up multi-homed systems, see the Release Notes for
CiscoWorks Common Services 3.0 (Includes CiscoView 6.1) on Windows.
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Running Installation Program—New Installation

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

To run the installation program:

Install the required software as described in the “Server Requirements” section on
page 1-3.

If you are running Windows, make sure Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1 and or Service Pack 2, the installation exits.

Insert the CD-ROM into the CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Yes to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click No.

e If you select Yes, and continue with the installation, the installation program
checks the name lookup and Dynamic Host Configuration Protocol (DHCP).

e If static IP address is not configured on your system, the DHCP-Enabled
Network Adapters dialog box appears. Click Yes to continue installation.

The Setup Type dialog box appears.
Select one of the following:

¢ Typical to select the components and install the selected components in the
default location (System Drive\Program Files\CSCOpx). This is the default
installation mode. (See the “New Installation—Typical” section.)

¢ Custom to select optional components, customize the settings, and to specify
the location. (See the “New Installation—Custom” section.)
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New Installation—Typical

Step 1

Step 2

Step 3

To perform a new installation using the Typical option:

Click Next to continue after you select the desired installation mode (see
Performing New Installation).

The Select Components dialog box appears.
Select the components you want to install:

If Common Services has been installed previously on this system, the list of
components will be different.

e Select Common Services 3.0 (CS) to install Common Services 3.0.

(Select this option if you do not want to install CiscoView 6.1 or Integration
Utility1.6).

e Select CiscoView 6.1 to install both CiscoView and Common Services.
e Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS
integration, see User Guide for CiscoWorks Integration Utility 1.6.)

e Click Select All to select all of the above components.
Click Next to continue.
The installation program checks dependencies and component requirements.

The System Requirements dialog box appears with the system requirements,
available space in the drive and Temp Directory (% TEMP%), and available
memory.

e If your system does not meet the requirements, a warning appears:
System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive name. Please select another
drive, or free some space on drive name.
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Step 4

Step 5

Step 6

Step 7

Step 8

If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement,

which may affect performance.

If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,

which may affect performance.

Click Next to continue installation.

The Change Admin Password dialog box appears.

Enter the admin password and confirm it.

For more information on passwords, see Appendix B, “Password Information.”

Click Next to continue installation.

The Change System Identity Account Password dialog box appears.

Enter the System Identity Account password and confirm it.

In a multi-server environment, you must configure all systems part of your

multi-server setup with the same System Identity Account password.

For more information on passwords, see Appendix B, “Password Information.”

Click Next to continue installation.

If you are installing Common Services 3.0 on a system for the first time, the
Create casuser dialog box appears after you enter the System Identity Account
password.

Click No to exit the installation and create casuser yourself and rerun the
installation. Casuser is the user who administers and maintains CiscoWorks

Server, without having administrative privileges.

Click Yes to allow the installation program to create the local user casuser.

If you select Yes and continue with the installation, the Summary dialog box

appears, displaying the summary of settings for the installation.

If you want to view passwords and other security sensitive data, click
Show Details. The Show Details button is visible only if Common Services

has been installed as one of the options.
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If you click Show Details, the Security Alert dialog box appears.

¢ Click Yes in the Security Alert dialog box to view the Summary page
with the passwords and other security sensitive data.

You can select and copy the data from the Summary page.
e Click Hide Details to hide the details.

If you want to change any settings, click Back.

Step9  Click Next to continue.
The installation proceeds.
If you are installing from a network drive, the installation might take longer to
complete. This happens especially for the installation of CiscoView device
packages.
The Restart dialog box appears after installation completes.

Step10  Select Yes and click Finish.

Caution  If you select to install Common Services, you must restart your system after

installation is complete. The installation of other CiscoWorks products may fail if
you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks
Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the
Installation.”
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New Installation—Custom

Step 1

Step 2

Step 3

To perform a new installation using the Custom option:

Click Next to continue after you select the desired installation mode (see
Performing New Installation).

The Choose Destination Folder dialog box appears with the default location
(System Drive\Program Files\CSCOpx).

To install in another location, click Browse and select the location.
We recommend that you specify a short path for the destination folder.

If the folder CSCOpx already exists in System Drive\Program Files with files or
folders, a message appears:

The selected folder, System Drive\program files\CSCOpx is not empty.
Mixing new and existing files can cause severe problems during
installation. Please remove all files from this folder or choose
another folder to install the product.

You must remove all files from this folder or choose another location to install
Common Services.

Click Next to accept the default location.

Or

Select another location, click OK, and click Next.

Do not select an encrypted directory. CiscoWorks does not support directory
encryption.

The Select Components dialog box appears.
Select the components you want to install:
e Select Common Services 3.0 (CS) to install Common Services 3.0.

(Select this option if you do not want to install CiscoView 6.1 or Integration
Utility1.6.)

e Select CiscoView 6.1 to install both CiscoView and Common Services.
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Step 4

Step 5

Step 6

Step 7

Performing New Installation W

e Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS
integration, see User Guide for CiscoWorks Integration Utility 1.6.)

¢ Click Select All to select all of the above components
Click Next to continue.
The installation program checks dependencies and component requirements.

The System Requirements dialog box appears. It displays the component
requirements, available space in the drive and Temp Directory(%TEMP%), and
available memory in megabytes.

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement,
which may affect performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,
which may affect performance.

Click Next to continue.

The Change Admin and Guest Password dialog box appears.

Enter admin and guest passwords and confirm them.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Change System Identity Account password dialog box appears.
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Step8  Enter the System Identity Account password and confirm it.

In a multi-server environment, you must configure all systems part of your
multi-server setup with the same System Identity Account password.

For more information on passwords, see Appendix B, “Password Information.”
The Change casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server, without
having administrative privileges.

Step9  Enter the casuser password and confirm it.

If you do not enter a password, the installation program generates a random
password and adds the new user casuser and the new group casusers to the
system.

Step10 Click Next to continue installation.

The Common Services Database Password dialog box appears.
Step11  Enter the CiscoWorks Common Services Database password and confirm it.
Step12 Click Next to continue installation.

The Web Server dialog box appears.

Step13  Enter HTTPS port, server administrator e-mail address, and the SMTP server
name.

The default HTTPS port number is 443. The SMTP server name is used by other
CiscoWorks applications. The HTTPS port and SMTP server name are mandatory.

Step14 Click Next to continue installation.

The Self-Signed Certificate dialog box appears. The webserver uses the
self-signed certificate while operating in secure mode.

Step15 Enter the country code, state, city, company, organization, and host name for
HTTPS.

The host name is mandatory.
Step16 Click Next to continue installation.
The Create Desktop Shortcut dialog box appears.

e Select the check box if you want to create a shortcut to CiscoWorks on your
desktop.

If Integration Utility has not been selected as one of the options, go to Step 19.
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Step17 Click Next to continue installation.

The Integration Utility dialog box appears.

Step18 Select one of the following:

Integrate Later to integrate with a third-party NMS after installation. This
completes the installation quickly and avoids installation failure caused by
errors in the third-party integration.

If you select Integrate Later, go to Step 19.

Integrate Now to integrate with a third-party NMS during installation.

If you select Integrate Now, perform steps a through g.

Click Next to continue.
The Integration Utility dialog box appears, displaying a list of adapters.

Select the adapter from the list of available adapters, or other to choose an
adapter that is not listed (you will be prompted to enter the path name of the
adapter), or none to integrate after the installation is complete.

If you select none, go to Step 19.
The Cisco Works Server Details box appears.

Enter the CiscoWorks Server name, protocol type (HTTP, HTTPS) and port
number.

If you want to integrate CiscoWorks application with the Network
Management platform, enter the CiscoWorks Server name, protocol type
(HTTP, HTTPS) and port number.

Click Next to continue.

The Integration Utility-NMIDB Updates dialog box appears. Specify whether
you want to enable download updates to NMIDB (Network Management
Integration Data Bundle) directly from Cisco.com.

Select one of the following:
- No to disable future updates from Cisco.com.
— Yes to enable future updates from Cisco.com.
If you select No, go to Step 19.
Click Next to continue.

The Cisco.com login page appears.
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g. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user account
and password on Cisco.com, contact your channel partner or enter a request
on the standard Cisco.com web site (www.cisco.com).

Step19 Click Next to continue.

The Summary dialog box appears with the summary of settings for the
installation.

e If you want to view passwords and other security sensitive data, click
Show Details. The Show Details button is visible only if Common Services
has been installed as one of the options.

a. Click Show Details, to display the Security Alert dialog box.

b. Click Yes in the Security Alert dialog box to view the Summary page
with the passwords and other security sensitive data.

You can select and copy the data from the Summary page.
e If you want to change any settings, click Back.
e If you want to hide the details, click Hide Details.
Step20 Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to
complete. This happens especially for the installation of CiscoView device
packages.

The Restart dialog box appears after installation completes.

Step21 Select Yes and click Finish.

A

Caution  If you select to install Common Services as one of the options, you must restart
your system after installation is complete. The installation of other CiscoWorks
products may fail if you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.
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To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks
Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the
Installation.”

Performing Upgrade Installation

Common Services 3.0 supports upgrade from:
e (CiscoWorks Common Services 2.2

You must install the patch emf£2.2-win-cscec013271.tar on the CS2.2
server, before upgrading to CS3.0.

The patch is available at:
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-cd-one

You need not install this patch if you have installed
Common Services2.2 Service Pack 3.

e (D One, 5th Edition
e CD One, 5th Edition + CORE 1.0
e CORE1L.0
The data is preserved when you perform an upgrade.

For a description of the different upgrade paths and their results, see “Upgrade
Paths” section on page 1-2.

Upgrading From Earlier Versions

You can upgrade to Common Services 3.0 by installing the new version on the
system currently running a previous version.

Upgrade installation preserves the settings from the product installed earlier.

We recommend that you save your data to a backup file before you perform the
local upgrade. If your installation fails, you can retrieve this saved data.

Upgrade overrides the previous versions. The old version will not be available
after you upgrade to Common Services 3.0.
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Earlier versions of CiscoWorks products are not fully compatible with

Common Services 3.0. The earlier versions are disabled when you upgrade. After
installation completes, data from the earlier versions is carried over to the new
version and the active state of the products is restored.

Backing Up Your Data

You can backup your data either from Common Services Admin (see Backing up
From Common Services Admin) or by using CLI (see Backing up Using CLI).

Backing up From Common Services Admin

To backup your data:

Step 1 Access the CiscoWorks desktop and log in.
For information, see Accessing the Server section and Logging In section in the
Userguide for CiscoWorks Common Services.

Step2  Select Server Configuration > Administration > Database Management >
Back Up Data Now.
The Back Up Data Now dialog box appears.

Step3  Enter the pathname of the target directory.
It is recommended that you use a different directory from the directory where
CiscoWorks is located, for example, C:\backups.

Stepd  Click Finish to start the backup.

Backing up Using CLI

To backup your data using CLI, run the following command at your command
prompt:

NMSROOT\bin\backup.pl BackupDirectory LogFile Num_Generations

BackupDirectory—Directory that you want to be your Backup directory.
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LogFile—Log file name

Num_Generations—Maximum backup generations to be kept in the backup
directory.

Before starting an upgrade, all currently scheduled jobs must be suspended.
Necessary data can then be exported during upgrade to the new version. This data
allows dependent applications to re-enable jobs after upgrade.

Running Installation Program—Upgrade Installation

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

To run the installation program:

Install the required software as described in the “Server Requirements” section on
page 1-3.

If you are running Windows, make sure Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1, and or Service Pack 2, the installation exits.

Insert the CD-ROM into a CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Yes to accept the license agreement and proceed with the installation
To deny the agreement and stop the installation, click No.

e If you select Yes, and continue with the installation, the installation program
checks the name lookup and Dynamic Host Configuration Protocol (DHCP).

e [If static IP address is not configured on your system, the DHCP-Enabled
Network Adapters dialog box appears. Click Yes to continue installation.

The Setup Type dialog box appears.
Select one of the following:

¢ Typical to select the components and install the selected components in the
default location (System Drive\Program Files\CSCOpx).This is the default
installation mode. (See the “Upgrade Installation—Typical” section.)
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¢ Custom to select optional components, customize the settings, and to specify
the location. (See the “Upgrade Installation—Custom” section.)

Upgrade Installation—Typical

Step 1

Step 2

To perform an upgrade installation using the Typical option:

Click Next to continue after you select the desired installation mode (see
“Performing Upgrade Installation” section).

If the installation program detects VPN monitor, or ACLM, or both, a dialog box
appears asking whether you want to continue upgrading on the same server, or
install Common Services 3.0 on a separate server.

If you continue with the upgrade, the system will uninstall the software as part of
RME 4.0 upgrade.

The Backup Data dialog box appears.

Enter a backup directory and click Next.

Or

Click Browse to select a backup directory and click Next.
The installation program performs backup.

If the backup fails, the Backup Data dialog box appears with the following
message:

Backup operation failed. Please look at Backup directory\backup.log
for the reason for failure.

¢ Click Retry to try backup again.
Or
e Click Exit to exit the installation.

If the backup fails, check the backup log files and correct the backup errors
specified in the backup log files.

If you still have the errors, contact the Technical Assistance Center (TAC). TAC
will guide you how to proceed upgrading without taking a backup.

If backup is completed, a dialog box appears with the following message:
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Step 3

Step 4

Step 5

Performing Upgrade Installation

This is an upgrade to CiscoView 6.1. The CiscoView related date like
Device List, Preferences etc, will not be preserved during the
upgrade. Do you want to continue?

Click Yes and continue with the installation.
If you click No, the installation exits.

If you have a different set of components in the previous version, the Select
Components dialog box will appear.

Select the components you want to install and continue with the installation.
The installation program checks component requirements.
The System Requirements dialog box appears.

The System Requirements dialog box displays the system requirements, available
space in the drive and Temp Directory (% TEMP%), and available memory in
megabytes.

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on
drive drive name.

e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement,
which may affect performance.

e If your system does not the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,
which may affect performance.

Click Next to continue.
The Change System Identity Account Password dialog box appears.
Enter the System Identity Account password and confirm it.

In a multi-server environment, you must configure all systems part of your
multi-server setup with the same system identity account password.

For more information on passwords, see “Password Information”appendix.
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Step 6

Step 7

Step 8

A

Click Next to continue.

The Summary dialog box appears with the summary of settings for the
installation.

e If you want to view passwords and other security sensitive data, click
Show Details. The Show Details button is visible only if Common Services
has been installed as one of the options.

a. Click Show Details, to display the Security Alert dialog box.

b. Click Yes in the Security Alert dialog box to view the Summary page
with the passwords and other security sensitive data.

You can select and copy the data from the Summary page.
e If you want to change any settings, click Back.
¢ Click Hide Details to hide the details.
Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to
complete. This happens because of the installation of CiscoView device packages.

The Restart dialog box appears after installation completes.

Select Yes, and click Finish.

Caution

If you have installed Common Services as one of the options, then you must
restart your system after installation is complete. The installation of other
CiscoWorks products may fail if you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks
Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the
Installation.”
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Performing Upgrade Installation

Upgrade Installation—Custom

Step 1

Step 2

The Custom option preserves the settings from the product installed earlier.
Dialog boxes appear with the settings from the previous installation. You can
accept these values or modify them.

To perform an upgrade installation using the Custom option:

Click Next to continue after you select the desired upgrade installation mode (see
“Performing Upgrade Installation” section).

If the installation program detects VPN monitor, or ACLM, or both, a dialog box
appears asking whether you want to continue upgrading on the same server, or
install Common Services 3.0 on a separate server.

If you continue with the upgrade, the system will uninstall the software as part of
RME 4.0 upgrade.

The Backup Data dialog box appears.

Enter a backup folder and click Next.

Or

Click Browse to select a backup folder and click Next.

The installation program performs backup.

If backup fails, the Backup Data dialog box appears with the following message:

Backup operation failed. Please look at Backup directory\backup.log
for the reason for failure.

e Click Retry to try backup again.
Or
¢ Click Exit to exit the installation.

If the backup fails, check the backup log files and correct the backup errors
specified in the backup log files.

If you still have the errors, contact the Technical Assistance Center (TAC). TAC
will guide you how to proceed upgrading without taking a backup.
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Step 3

Step 4

Step 5

If backup is completed, a dialog box appears with the following message:

This i1s an upgrade to CiscoView 6.1. The CiscoView related date like
Device List, Preferences etc, will not be preserved during the
upgrade. Do you want to continue?

Click Yes and continue with the installation.
If you click No, the installation exits.

If you have a different set of components in the previous version, the Select
Components dialog box will appear. The number of components in the dialog box
will vary based on the previous installation.

Select the components you want to install and continue with the installation.
The installation program checks component requirements.
The System Requirements dialog box appears.

e The System Requirements dialog displays the system requirements, available
space in the drive and Temp Directory (%TEMP%), and available memory in
megabytes.If your system does not meet the requirements a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Free some space on
drive drive name

e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement,
which may affect performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,
which may affect performance.

Click Next to continue.
The Change Admin and Guest Password dialog box appears.
Enter CiscoWorks admin and guest passwords and confirm them.

You may change the passwords for the admin and guest users. To keep the existing
passwords, leave the fields blank and click Next to continue installation.

For more information on passwords, see Appendix B, “Password Information.”
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Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Performing Upgrade Installation

Click Next to continue installation.
The Change System Identity Account Password dialog box appears.
Enter the System Identity Account password and confirm it.

In a multi-server environment, you must configure all systems part of your
multi-server setup with the same system identity account password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue.
The Change casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without
having administrative privileges.

Enter the causer password and confirm it.

This password must conform to the system administrator policies. The installation
program adds the user casuser and the group casusers to the system. If you do not
enter a password, the setup program will generate a random password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Common Services Database Password dialog box appears.

Enter the password, and confirm it.

Leave the fields blank to use the existing password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Web Server Configuration dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server
name.

The default HTTPS port number is 443. The SMTP server name is used by other
CiscoWorks applications. The HTTPS port and SMTP server name are mandatory.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the
Self-signed certificate while operating in secure mode. By default, the installation
program uses the existing Self- signed Certificate information.
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Step 15

Step 16

Step 17

If you want to generate a new certificate, uncheck the Keep existing certificate
check box, and enter the country code, state, city, company, organization, and host
name for HTTPS. The host name is mandatory. You can leave the other fields
blank.

Click Next to continue installation.
The Shortcut Creation dialog box appears.

e Select the check box if you want to create a shortcut to CiscoWorks on your
desktop.

If Integration Utility has not been selected as one of the options, go to Step 18.
Click Next to continue installation.

The Integration Utility dialog box appears.

Select one of the following:

¢ Integrate Later to integrate with a third-party NMS after installation. This
completes the installation more quickly and avoids installation failure caused
by errors in the third-party integration.

If you select Later, go to Step 18.

e Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through g.

a. Click Next to continue. The Integration Utility dialog box appears, displaying
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose
an adapter that is not listed (you are prompted to enter the path name of the
adapter), or select none to integrate after the installation is complete.

If you select none, go to Step 18.
The Cisco Works Server Details box appears.

c¢. Enter the CiscoWorks Server name, protocol type (HTTP, HTTPS) and port
number.

If you want to integrate CiscoWorks application with the Network
Management platform, enter the CiscoWorks Server name, protocol type
(HTTP, HTTPS) and port number.

d. Click Next to continue.
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Step 18

Step 19

Step 20

Performing Upgrade Installation

The Integration Utility -NMIDB Updates dialog appears.Specify whether you
want to enable download updates to NMIDB (Network Management
Integration Data Bundle) directly from Cisco.com.

e. Select one of the following:
— No to disable future updates from Cisco.com.
— Yes to enable future updates from Cisco.com.
If you select No, go to Step 18
f. Click Next to continue.
The Cisco.com login page appears.
g. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user account
and password on Cisco.com, contact your channel partner or enter a request
on the standard Cisco.com web site.

Click Next to continue.

The Summary dialog box appears, displaying the summary of settings for the
installation.

To view passwords and security sensitive data, click Show Details.

The Show Details button is visible only if Common Services has been installed
as one of the options.

The installation program displays only the new and changed passwords. You can
select and copy the data from the Summary dialog box.

Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to
complete. This happens especially for the installation of CiscoView device
packages.

The Restart dialog box appears after installation completes.

Select Yes and click Finish.
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Caution

If you have installed Common Services as one of the options, then you must
restart your system after installation is complete. The installation of other
CiscoWorks products may fail if you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks
Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the
Installation.”

Reinstalling Common Services

You can reinstall Common Services 3.0 by running the installation program on the
system currently running the product.

Reinstallation preserves the settings from the previous installation.

We recommend that you save your data to a backup file before you start
reinstallation. If your installation fails, you can retrieve this saved data. To do a
back up, see “Backing Up Your Data” section on page 2-18.

Reinstallation overrides the previous installation.
During reinstallation:

¢ Ifyouleave any field blank, CiscoWorks will use the values from the previous
installation.

e If you have not entered a password for CiscoWorks admin or guest user
during the previous installation, you must enter a new password for the
installation to proceed.

e Ifyou select Custom option during reinstallation, all the dialog boxes display
the default values or the settings from the previous installation. You can
accept these values or modify them.

e The installation attempts to use existing passwords. If the installation fails to
generate random passwords, you may provide the passwords manually.

Installation and Setup Guide for CiscoWorks Common Services 3.0 (Includes CiscoView) on Windows
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Reinstalling Common Services W

¢ The installation does not use the randomly generated password if the
password does not comply with the policies set by the local administrator.

¢ You can preserve the self-signed certificate. Select Keep existing certificate
option to configure the webserver to use existing certificate.

Running Re-installation Program

Step 1

Step 2

Step 3

Step 4

Step 5

The Back Up Data Now dialog box appears before you run the installation
program. Make sure that you have backed up your data. If your installation fails,
you can retrieve this saved data. If backup fails, an error message appears.

To run the re-installation program:

Install the required software as described in the “Server Requirements” section on
page 1-3.

If you are running Windows, make sure Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1, and or Service Pack 2, the installation exits.

Insert the CD-ROM into the CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Yes to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click No.

e If you select Yes, and continue with the installation, the installation program
checks the name lookup and Dynamic Host Configuration Protocol (DHCP).

e [If static IP address is not configured on your system, the DHCP-Enabled
Network Adapters dialog box appears. Click Yes to continue installation.

The Setup Type dialog box appears.
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Step 6

Select one of the following:

¢ Typical to select Common Services components and install the selected
components in the default location.This is the default installation mode. (See
the “Re-installation—Typical” section.)

¢ Custom to select optional components, customize the settings, and to specify
the location. (See the “Re-installation—Custom” section.)

Re-installation—Typical

Step 1

Step 2

Step 3

To perform re-installation using the Typical option:

Click Next to continue after you select the desired reinstallation mode (see
Running Re-installation Program).

The Backup Data dialog box appears.

Enter a backup directory and click Next.

Or

Click Browse to select a backup directory and click Next.
The installation program performs backup.

If backup fails, the Backup Data dialog box appears with the following message:

Backup operation failed. Please look at Backup directory\backup.log for
the reason for failure.

¢ Click Retry to try backup again.
Or

¢ Click Exit to exit the installation.
If backup is completed, the Select Components dialog box appears.
Select the components you want to install:

¢ Select Common Services 3.0 (CS) to install Common Services 3.0.

(Select this option if you do not want to install CiscoView 6.1 or Integration
Utility1.6.)

¢ Select CiscoView 6.1 to install both CiscoView and Common Services.
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Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS
integration, see User Guide for CiscoWorks Integration Utility 1.6.)

Click Select All to select all of the above components.

Step4  Click Next to continue.

The installation program checks component requirements.

The System Requirements dialog box appears. It displays the component
requirements, available space in the drive and Temp Directory(%TEMP%), and
available memory in megabytes.

If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

If your system does not have the minimum CPU speed, a warning appears:
Warning: Current CPU speed is less than the minimum requirement,
which may affect performance.

If your system does not the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,
which may affect performance.

Step5  Click Next to continue.

The installation proceeds. The Summary dialog box appears, with the summary of
settings for the installation.

If you want to view passwords and security sensitive data, click Show
Details. The Show Details button is visible only if Common Services has
been installed as one of the options.

Click Show Details, to display the Security Alert dialog box.

[ 78-16497-01
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Step 6

Step 7

A

¢ Click Yes in the Security Alert dialog box to view the Summary page with the
passwords and other security sensitive data.

You can select and copy the data from the Summary page.
e If you want to change any settings, click Back.
e If you want to hide the details, click Hide Details.
Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to
complete. This happens because of the installation of CiscoView device packages.

The Restart dialog box appears after installation completes.

Select Yes, and click Finish.

Caution

If you have installed Common Services as one of the options, you must restart
your system after installation is complete. The installation of other CiscoWorks
products may fail if you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.

To prepare the client system for use, see “Chapter 3, “Preparing to Use
CiscoWorks Common Services.”

For troubleshooting information, see the Appendix A, “Troubleshooting the
Installation.”

Re-installation—Custom

The Custom option preserves the settings from the product installed earlier.
Dialog boxes appear with the settings from the previous installation. You can
accept these values, or modify them.
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Step 1

Step 2

Step 3

Step 4

Reinstalling Common Services W

To perform a reinstallation using the Custom option:

Click Next to continue after you select the desired reinstallation mode (see
Running Re-installation Program).

The Backup Data dialog box appears.

Enter a backup folder and click Next.

Or

Click Browse to select a backup folder and click Next.

The installation program performs backup.

If backup fails, the Backup Data dialog box appears with the following message:

Backup operation failed. Please look at Backup directory\backup.log
for the reason for failure.

¢ Click Retry to try backup again.
Or
¢ Click Exit to exit the installation.
If backup completes, the Select Components dialog box appears.
Select the components you want to install:
¢ Select Common Services 3.0 (CS) to install Common Services 3.0.

(Select this option only if you do not want to install CiscoView 6.1 or
Integration Utility1.6.)

¢ Select CiscoView 6.1 to install both CiscoView and Common Services.
e Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS
integration, see User Guide for CiscoWorks Integration Utility 1.6.)

e Click Select All to select all of the above components.
Click Next to continue.
The installation program checks component requirements.

The System Requirements dialog box appears. It displays the component
requirements, available space in the drive and Temp Directory(% TEMP%), and
available memory in megabytes.
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Step 5

Step 6

Step 7

Step 8

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may
affect performance.

e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name. Please select
another drive, or free some space on drive drive name.

e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement,
which may affect performance.

e If your system does not the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement,
which may affect performance.

Click Next to continue.
The Change Admin and Guest Password dialog box appears.
Enter CiscoWorks admin and guest passwords and confirm them.

You may change the passwords for the admin and guest users. To keep the existing
passwords, leave the fields blank and click Next to continue installation.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.
The Casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without
having administrative privileges.

Enter the casuser password and confirm it.
Leave the fields blank to use the existing password.
This password must conform to the system administrator policies.

e If you do not enter a password, the setup program will generate a random
password for you.

e [If casuser does not exist, it will be created. The installation program adds the
user casuser and the group casusers to the system.

For more information on passwords, see Appendix B, “Password Information.”
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Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Reinstalling Common Services W

Click Next to continue installation.

The Common Services Database Password dialog box appears.

Enter the password, and confirm it.

Leave the fields blank to use the existing password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue.

The Web Server Configuration dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server
name.

The default HTTPS port number is 443. The SMTP server name is used by other
CiscoWorks applications. You may change the HTTPS port number,
Administrator’s E mail address, and the SMTP server name. Click Next to keep
the existing information.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the
self-signed certificate while operating in secure mode. You may change the
Self-Signed Certificate information. By default, the installation program uses the
existing Self- signed Certificate information.

If you want to generate a new certificate, uncheck the Keep existing certificate
check box, and enter the country code, state, city, company, organization, and host
name for HTTPS. The host name is mandatory. You can leave the other fields
blank.

Enter the country code, state, city, company, organization, and host name for
HTTPS.

Click Next to continue installation.
The Shortcut Creation dialog box appears.

¢ Select the check box if you want to create a shortcut to CiscoWorks on your
desktop.

If Integration Utility has not been selected as one of the options, go to Step 18.
Click Next to continue installation.

The Integration Utility dialog box appears.
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Step17  Select one of the following:

Integrate Later to integrate with a third-party NMS after installation. This
completes the installation quickly and avoids installation failure due to errors
in the third-party integration.

If you select Later, go to Step 18.

Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through g.

Click Next to continue. The Integration Utility dialog box appears, displaying
a list of adapters.

Select the adapter from the list of available adapters, or select other to choose
an adapter that is not listed (you will be prompted to enter the path name of
the adapter), or select none to integrate after the installation is complete.

If you select none, go to Step 18.
The Cisco Works Server Details box appears.

Enter the CiscoWorks Server name, protocol type (HTTP, HTTPS) and port
number.

If you want to integrate CiscoWorks application with the Network
Management platform, enter the CiscoWorks Server name, protocol type
(HTTP, HTTPS) and port number.

Click Next to continue.

The Integration Utility -NMIDB Updates dialog box appears. Specify
whether you want to enable download updates to NMIDB (Network
Management Integration Data Bundle) directly from Cisco.com.

Select one of the following:
— No to disable future updates from Cisco.com.
— Yes to enable future updates from the Cisco.com.
If you select No, go to Step 18.
Click Next to continue.
The Cisco.com login page appears

Enter your Cisco.com user ID and password.
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Step 18

Step 19

Step 20
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Reinstalling Common Services W

You must have Cisco.com login privileges. If you do not have a user account
and password on Cisco.com, contact your channel partner or enter a request
on the standard Cisco.com web site.

Click Next to continue.

The Summary dialog box appears with the summary of settings for the
installation.

To view passwords and security sensitive data, click Show Details.

The Show Details button is visible only if Common Services has been installed
as one of the options.

The installation program displays only the new and changed passwords. You can
select and copy the data from the Summary dialog box.

Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to
complete. This happens especially for the installation of CiscoView device
packages.

The Restart dialog box appears after installation completes.

Select Yes and click Finish.

Caution

If you have installed Common Services as one of the options, then you must
restart your system after installation is complete. The installation of other
CiscoWorks products may fail if you do not restart.

See “Checking for Installation Errors” section on page 2-38 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks
Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the
Installation.”
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Checking for Installation Errors

If errors occur during installation, you can look at the installation log to determine
the error. This log is located in the root directory on the drive where the operating
system is installed.

The default is C:\Ciscoworks_setupXXX.log, where XXX is a sequential number
starting from 001. The number signifies the installation instance. For example,
001 shows that the log file is created during the first installation.

Each installation creates a log that is saved as a different file, for
example,C:\Ciscoworks_setup003.log. Check the most recent log file for error
messages.

Verifying Installation

You can verify product installation by entering the command pdshow from your
command prompt. The following processes must appear:

e Apache

¢ CMFOGSServer
e CSRegistryServer
¢ CmfDbEngine

e CmfDbMonitor

e DCRServer

e EDS

e EDS-GCF
e EDS-TR

e ESS

e EssMonitor

e LicenseServer

e Proxy

¢ RmeGatekeeper
¢ RmeOrb
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e Tomcat
e TomcatMonitor
e diskWatcher

e jrm

Uninstalling Common Services

A

Use the Uninstall option to remove Common Services files and settings. You must
be logged in as administrator to remove Common Services.

You cannot uninstall Common Services when you have CiscoView installed.
Before uninstalling Common Services, uninstall CiscoView.

For example, if you select Common Services without selecting CiscoView, the
following message appears:
Cannot uninstall CiscoWorks Common Services.

It is required for CiscoView.

Uninstall all applications dependent on Common Services before uninstalling
Common Services.

Caution

Step 1

Step 2

You must use the Uninstall script to remove the product. If you try to remove
Common Services or its components manually, you may damage your system.

To uninstall Common Services:

From the Windows desktop, select Start > Programs > CiscoWorks >
Uninstall CiscoWorks.

The Uninstallation dialog box appears with the installed components.
Select the components you want to remove and click Next.

Or

Click Select All to uninstall all the components and click Next.

The Uninstallation dialog box lists the selected components.

[ 78-16497-01

Installation and Setup Guide for CiscoWorks Common Services 3.0 (Includes CiscoView) on Windows g




Chapter2 Installing CiscoWorks Common Services |

I Uninstalling Common Services

Step3  Click Next to continue uninstallation.
Or
Click Back to return to the component selection box.

If you have selected Uninstall All, you cannot return to the component selection
box using Back button.

Messages about uninstallation appears and the Information dialog box appears at
the end of the uninstallation.

Step4  Click OK in the Information dialog box to finish the uninstallation process.

Step5  Restart the system after uninstallation to make sure all the registry entries are
deleted.
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